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2Overview
This software allows you to view all the materials of the training guide
and course materials in an organized fashion.

It allows you to use the special features of the software to take notes,
do research, and perform tasks that will help you make progress in
achieving your goals.

You can access additional resources provided as links that open in your
default browser, and even add links to resources on your own.

Note: Although the content inside the software shown in this guide
may look different than what you are currently viewing, the functions
of the software work exactly the same.

If you have any specific issues or bugs with the usage or functions of
the software, please submit a support ticket to us at the web address
below and we’ll get back with you promptly.

Click here to submit a support request

Or visit https://customerassistance.net

If you have any issues with product access, sales/billing/refunds, or
anything else non-technical related, please contact the product
provider directly (the person or company whom you obtained the
software from).



3Starting the Software
After you download and install the software, click the software icon on
your desktop to start it.

Your first view of the software should look like this (but likely with
different course content):

The software opens with the “File” tab selected. From here you can
view the main guide, save changes you make, and print the guide out:



4Standard Features
Attachments:

Most chapters, and some individual pages, will have attachments like
videos, documents, spreadsheets, mind maps, and tasks that can be
viewed directly inside the software when clicked.

They will suddenly appear at the top of the menu as you read through
the guide.

You can add your own attachments as well by clicking on the
“Annotations” menu item and selecting the attachment type you want
to add:

You can also view all attachments and documents you have in the
software by clicking “Documents” in the menu bar:



5

Double-clicking any of the documents in this panel will open up the
document in the software, just as it will when clicking the attachments
as you are viewing the guide.
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Highlights:

Highlights are a good way to give yourself indicators throughout the
guide for when you have an attached note or link assigned to a page
you are viewing.

To add a highlight, select the “Annotations” menu item and click the
“Highlight” icon.
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Choose the color and opacity and then swipe across any text in the
page you are viewing to add a highlight:

Next, right-click on the highlighted text and choose “Properties” to add
a tool tip for the highlight:
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You add a tool tip by typing something in the “Comment” box. What
you type here will show up as a tool tip when you hover your mouse
cursor over the highlighted text.

In this example, the tool tip we want to see is a reminder that we have
a note and link attached related to what we are highlighting.
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Notes and Links:

Add a note to the any page by clicking the Note icon at the right side of
the software:
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The Note panel slides out and you can add anything as note that you
like.

To add a link to a page, click the “Add” link icon in the Annotations
menu bar:

This brings up the link box where you can add a link, and a caption and
description for it:
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To view the link you added, click the link icon in the right-side of the
software:

The link panel slides out and you can see the link, caption and
description you gave it:
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You can view the page the link points to in your default browser by
either clicking the arrow or double-clicking inside the link box.

And you can edit the link by clicking the link editor icon:
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14Attachments – Special Feature Overview
One of the special features of the software is the ability to add and
view attachments directly inside the software.

You can add and view pdfs, documents, text files, videos, mind maps,
diagram charts, and kanban tasks (works similar to Trello).

In the example below, you can see two different attachments for this
page of the guide: It has a video attachment and a mind map
attachment, corresponding to the lesson in the guide you are viewing.

Here’s a close up view:
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The Video Attachment

Clicking the “Lesson 2 Video” attachment starts the video directly
inside the software as seen below:

You can watch the video, adjust the volume, and speed it up if you like.

If you want to view the video at full screen, right-click on the video or
play bar while the video is playing, hover your mouse cursor over
“Zoom” and choose “Full Screen”. [See the screenshot below]
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To exit the Full screen mode, double-click directly on the video or
choose the “exit full screen” icon at the lower right corner of the video.

[Note: The “Full screen” option is only available when the video is
actually playing. If the video is “buffering”, paused, or stopped, the
option to select “Full screen” is greyed out and not available.]

When you are ready to return to the main guide, select the “File” tab,

and then click the red button with the white “X” and the software
will close the video and open the main guide again.

Important:

Only click the big “X” at the top right corner if you want to close
the entire software program.
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The Mind Map Attachment

Now that we’ve closed the “Lesson 2 Video” and are back to viewing
the main guide, let’s see the second attachment for this lesson: The
“Autoresponder Mind Map”.

Click on the attachment and the software screen slides from right to
left revealing the mind map [see the screenshot below]:
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When you open a mind map attachment, note that what you see in the
menu bar looks like this:

But now click on any of the elements inside of the mind map, and you’ll
see a new menu item called “Style” appear:
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Click on the “Style” menu item that now appears, and you’ll see a lot of
new options available to you:

On the mind map screen, you can interact with the elements, edit
them, and add new mind map elements on your own.
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And with the “Style” options visible, you can change the colors, add
your own notes, icons, and links to each element.

Two features of the Mind Map we are working on improving:

1. Currently, we recommend not adding “Images” to the mind
map, as they do not always scale well. If you add an image and
do not like the way it looks, you must close the software without
saving your changes in order to get rid of the image – we’re
working on adding a better solution for this option.

There are a ton of icons available to choose from for the mind map, and
we recommend using those instead of images.

2. We also do not recommend using the “Relationship” feature to
connect related elements on the mind map at this current time,
because the behavior is unpredictable. You’ll find the
“Relationship” item when you click the “Home” tab:

For now, if you want to connect elements together in a “Relationship”,
we recommend using the same color for those elements to show the
relationship and not the “Relationship” feature itself.
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One additional note about the mind map feature:

When clicking to expand an element, you may see the branches look
rather gangly and jumbled together like below:

But the remedy for this is simple: Just click the central element to
collapse everything and then click it again to expand, and everything
will look as it should.

Click to collapse and click again to expand.
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Now everything extends out as it should.

When you done with the mind map attachment, close it using the same
procedure as closing the video attachment: Click the red “close” button
with the white “X”.

The attachment closes and you’ll see the main guide again.

We still have one more attachment to look at for Lesson 2.
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The Kanban Task Attachment

Although it’s not visible when looking at the Lesson 2 attachments area,
there is another attachment waiting to be discovered.

To see it, click on the down-turned arrow in the attachments section:

And now we see the additional attachment become visible:

It’s a “Task” (Kanban) attachment. Click it to view the attachment [see
the screenshot below].
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Note: the screenshot shows 2 columns: “Not Started” and “In
Progress”, but there are actually 4. The other two columns are not
shown so we can fit the screenshot into this guide.

The Kanban Task attachment works similar to Trello, but is not meant
to be a full-featured project/task manager like Trello. Its purpose is to
provide you with simple tasks related to the training course only.
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What you can do:

 Add new cards
 Add checklists
 Add colored labels
 Add notes
 Add links
 Add descriptions
 Move cards from one column to another
 Move the order of cards in each column
 When adding a new Kanban Task attachment, you can also change

the main column headings [For example, you can change “Not
Started” to “Braindump” or something else for the first column,
and so on].

 When adding a new Kanban Task attachment, you can also add
new colored labels, and in any amount.

Important: You can only change the column headings and add new
colored labels when creating a new Kanban Task attachment. These
cannot be changed for already existing Kanban Task attachments.

What you cannot do:

 The main thing to note about what you cannot do with the
Kanban Task attachment is you cannot add scheduling
information to cards (due dates/time).
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The tasks are meant to be viewed in bite-sized chunks (per lesson/per
chapter) and easy for you to do at your convenience – not pushed at
you to complete within a given time-frame.

Completing the tasks or not completing them is entirely up to you. But
we believe you’ll get a lot more benefit out of the course by completing
some, or all, of them.

So now let’s have a closer look at this Kanban Task example:

The first card has a directive title “Aweber: Visit the Site and Examine
the Features”.

You can see that it has a green colored label, a description, a note, and
a link assigned to it.

Double-click anywhere inside the card to bring up the card dialog box:
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Here we can edit the card title, change the label color, and
view/add/edit the description.

This is where you can also add a checklist:

If necessary, resize the dialog window vertically so you can see it better,
and then click the “+” to add as many checklist items as you want.

In the above screenshot, we added 3.
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After you add the items, click on each one to give the items a different
descriptive name:

We’ve given each item a different name, and we have checked off one
of the items as completed.

The software automatically reflects the percent of completion.

Now we’ll click ok, and return to the card view, and you can see the
checklist icon and the number of completed checklist tasks out of those
assigned:

Note: If you decide you no longer want one or some of the checklist
items, double-click on the card to bring up the dialog box again, select
the item you want to delete and then first click the “X” (cancel edit),
and then click delete “-“.
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1. Click “Cancel Edit”

2. Click “Delete”

You may not have to do this every time you want to delete a checklist
item, but the software assumes you want to edit the items initially,
which is why you’ll sometimes need to click “Cancel Edit” first.

Now let’s have a look at the Card Note:

With the card selected, you can view the attached note by clicking the
Note icon on the menu bar, or by clicking directly on the note icon
inside the card:



30

Click directly on the note icon, give it a second, and the note box
appears:

You can view the note, edit it, add a link, and add some formatting to it
if you like.

To visit the page in your browser the link points to, hover your mouse
cursor on the link, press down the “Ctrl” key on your computer
keyboard, and then click.

When you are done, click “Ok” and return to the board.
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Back in the board view, there is a link attached to the card. You cannot
see the link by clicking on the link icon. The icon simply tells you that
there is a link to view for this card.

To see the link attached to any card, make sure the card is selected, and
then click on the links icon on the right sidebar of the software:

As soon as you do that, the link panel will fly out from the side revealing
the link(s) assigned for that selected card [see the screenshot below]:
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You can visit any of the pages inside the link panel by either clicking on
the arrow icon as shown in the screenshot above, or by simply double-
clicking anywhere inside the rectangular area.

Any and all links will open the page in your default web browser.

This link panel is also where you can edit any of the links [see the
screenshot below]:
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Click the “edit” icon for any link, and the link editor appears:

Here you can give the link a new Caption, change the URL, and type a
new Description if you want.
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To add a new Note or new Link to any card, select the card you want to
add a new Note or Link to, and click either the Note icon or the Link
icon in the menu bar:

Editing the Board for the Kanban Task Attachment:

To edit the Board name and description, click the first “Edit” menu icon
at the top left:

That will bring up the Board editor:
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Here you can change the Board name as it will appear in the
attachments for the page in the guide it is assigned to, and change the
description.
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